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1 Bienvenue dans le monde de GUITAR RIG !

 

GUITAR RIG KONTROL est la solution complète pour les guitaristes et bassistes. Le pédalier
RIG KONTROL conçu pour le live s'intègre de manière transparente au logiciel GUITAR RIG et
fournit un son de qualité studio grâce à son interface audio intégrée. S’il est conçu et optimisé
pour GUITAR RIG, il répond également aux standard de l’industrie et assure une prise en char-
ge complète de la norme MIDI, lui permettant de fonctionner parfaitement avec la plupart des
logiciels audio professionnels.

Le RIG KONTROL se connecte à votre ordinateur via USB 2.0, qui lui fournit également son
alimentation électrique. Le pédalier possède deux entrées acceptant les signaux de niveau ins-
trument ou ligne. Une sortie ligne à deux canaux se connecte à votre système d’écoute et un
jack stéréo permet un contrôle au casque à un volume indépendant.

Comme contrôleur, le RIG KONTROL propose neuf interrupteurs et une pédale qui vous per-
mettent de contrôler quasiment toutes les fonctions de GUITAR RIG. En outre, il est équipé de
prises MIDI et de deux entrées analogiques permettant de connecter des contrôleurs externes.

Dans les chapitres qui suivent, vous en apprendrez plus sur les caractéristiques du RIG KON-
TROL et découvrirez comment en faire le meilleur usage. Veuillez lire ce manuel attentivement
afin de vous familiariser avec ce produit.

Bienvenue dans le monde de GUITAR RIG !
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2 Avant de commencer – Remarques importantes

 

Commençons par le commencement : avant d’utiliser le GUITAR RIG, nous vous conseillons
de lire ce chapitre attentivement.

2.1 Numéros de série et plaque signalétique
 

GUITAR RIG Kontrol est livré avec deux numéros de série. Le numéro de série du RIG KON-
TROL se trouve sur la face inférieure du pédalier, accompagné de la plaque signalétique indi-
quant le nom du modèle du produit ainsi que d'autres informations techniques. Le numéro de
série permettant d’activer GUITAR RIG se trouve sur la pochette du DVD du produit.

2.2 Utilisation du boîtier en toute sécurité
 

Veuillez lire attentivement les instructions qui suivent pour prévenir tout risque pour votre san-
té et éviter d’endommager le produit.

2.2.1 Avertissement
 

Pour éviter toute lésion auditive, veuillez prendre en compte les avertissements suivants :

▪ Utilisé avec un amplificateur, un casque ou des enceintes actives, ce produit peut générer
des sons à des volumes susceptibles d’entraîner des lésions auditives.

▪ Par précaution, réglez tous les volumes au minimum avant d’utiliser le RIG KONTROL.
Augmentez progressivement les contrôles de volume tandis que du son est produit par le
système afin d’ajuster le niveau d’écoute désiré.

▪ Ne l’utilisez pas à un volume élevé pendant des périodes trop longues. Si vous éprouvez
des problèmes d’audition ou des sifflements dans les oreilles, consultez immédiatement
un médecin spécialiste de l’audition.

Avant de commencer – Remarques importantes
Numéros de série et plaque signalétique
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2.2.2 Recommandations
 

Pour vous assurer que le RIG KONTROL (ou tout autre matériel connecté à celui-ci) ne soit pas
endommagé lors de son utilisation ou de son entretien, veuillez suivre les instructions suivan-
tes :

▪ N’ouvrez pas l’appareil, ne tentez pas de le démonter ni de modifier en quoi que ce soit
ses composants internes. L’appareil ne contient pas d’éléments réparables par l’utilisa-
teur. S’il semble mal fonctionner, arrêtez immédiatement de l’utiliser et faites-le contrôler
par une personne qualifiée.

▪ N’exposez pas l’appareil à la pluie et ne l’utilisez pas près de l’eau ni dans une atmosphè-
re trop humide.

▪ Empêchez tout liquide ou tout autre objet de pénétrer dans l’appareil.

▪ N’utilisez et ne stockez jamais l’appareil dans des endroits à température élevée (par
exemple à la lumière du soleil dans un véhicule fermé ou près d’un radiateur) ou sujets à
de fortes vibrations.

▪ Ne disposez pas le RIG KONTROL en équilibre instable, dans une position où il pourrait
tomber accidentellement. Avant de déplacer l'appareil, débranchez tous les câbles qui lui
sont connectés.

▪ Avant d’allumer ou d’éteindre un appareil quelconque, ramenez les niveaux de volume à
leurs minimums.

▪ N’exercez pas de pression démesurée sur les potentiomètres ni sur les connecteurs.

▪ Lorsque vous nettoyez le RIG KONTROL, utilisez un tissu doux et sec. N’utilisez jamais
de diluant, solvant, liquide de nettoyage ni lingette de nettoyage imprégnée de produits
chimiques.

2.2.3 Instructions concernant le traitement des déchets
 

Si ce produit venait à être définitivement endommagé, ou si vous désiriez vous en débarrasser,
veuillez observer la réglementation en vigueur dans votre pays concernant le traitement des dé-
chets électroniques.

Avant de commencer – Remarques importantes
Utilisation du boîtier en toute sécurité
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2.3 Avis de non-responsabilité
 

La société Native Instruments GmbH ne peut être tenue responsable des dégâts ou des pertes
de données occasionnés par une mauvaise utilisation ou une modification du RIG KONTROL.

Les informations contenues dans ce manuel sont réputées correctes à la date d’impression ou
de mise en ligne. Cependant, Native Instruments se réserve le droit d’effectuer des change-
ments de spécifications à tout moment, sans préavis ni obligation de mettre à jour les appa-
reils existants.

Avant de commencer – Remarques importantes
Avis de non-responsabilité
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3 Le boîtier RIG KONTROL

 

Ce chapitre présente le boîtier RIG KONTROL.

3.1 Panneau supérieur
 

Le panneau supérieur du RIG KONTROL

(1) Les interrupteurs au pied (ou « footswitches ») peuvent être configurés dans le logiciel pour
accomplir des actions telles que passer d’un preset à un autre ou encore allumer/éteindre un
composant particulier. Chaque interrupteur possède un diode indiquant s’il est activé. La ran-
gée supérieure est étiquetée par les fonctions les plus fréquemment utilisées dans GUITAR
RIG, correspondant aux pré-assignations du logiciel.

Le boîtier RIG KONTROL
Panneau supérieur
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(2) La pédale d’expression peut être utilisée pour contrôler tout paramètre continu du logiciel,
comme un volume ou une wah-wah. Un interrupteur de bout de course situé sous la pédale
d'expression est lui aussi librement assignable.

(3) Indique le numéro du Preset actuellement chargé.

(4) Cet indicateur à diodes affiche le niveau du signal audio en entrée. Les diodes rouges indi-
quent une saturation : elles ne doivent jamais s’allumer. Si nécessaire, diminuez le gain d’en-
trée correspondant.

(5) Cet indicateur à diodes affiche le niveau du signal audio en sortie. Les diodes rouges indi-
quent une saturation : elles ne doivent jamais s’allumer. Si nécessaire, diminuez le niveau de
sortie.

(6) Cette diode indique si le RIG KONTROL reçoit un signal MIDI d’un séquenceur ou d’un au-
tre contrôleur.

(7) Cette diode indique si l’interrupteur situé sous la pédale est activé ou non.

3.2 Panneau arrière
 

Le panneau arrière du RIG KONTROL

(1) L'interrupteur Inst/Line permet de régler la sensibilité des entrées Input 1 et 2. Lorsque
l’interrupteur est sorti, ces entrées conviendront à des signaux d’instruments tels qu’une guita-
re ou une basse ; lorsqu’il est enfoncé, les entrées conviendront aux signaux de niveau ligne.
Le type d'entrée sélectionné est indiqué sur le panneau supérieur du boîtier.

(2) Ce curseur contrôle le gain de l’entrée Input 1.

Le boîtier RIG KONTROL
Panneau arrière
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(3) La prise de l’entrée Input 1 (jack 6,35 mm, trois points (TRS) symétrique) peut recevoir
des signaux de niveau ligne ou instrument, suivant la position de l’interrupteur Line/Inst. Vous
pouvez y brancher une guitare, une guitare basse, un clavier ou encore le canal gauche d'un
appareil stéréo.

(4) La prise de l’entrée Input 2 (jack 6,35 mm, trois points (TRS) symétrique) peut recevoir
des signaux de niveau ligne ou instrument, suivant la position de l’interrupteur Line/Inst. Vous
pouvez y brancher une deuxième guitare, guitare basse, un clavier ou encore le canal droit
d’un appareil stéréo.

(5) Ce curseur contrôle le gain de l’entrée Input 2.

(6) Ces prises transmettent le signal sortant de l’interface audio. Connectez les deux pour obte-
nir un son stéréo.

(7) L’amplification de sortie peut être réglée sur le niveau maximal ou sur -14 dB.

(8) Contrôle de volume indépendant pour la sortie casque.

(9) Cette fiche sert à brancher un casque stéréo.

(10) Pour connecter des pédales d’expression, interrupteurs au pied, pédales de volume ou
boîtiers-sélecteurs externes.

(11) Le RIG KONTROL intègre une interface MIDI avec une entrée et une sortie. Le RIG KON-
TROL n’a pas besoin de MIDI pour envoyer les messages de contrôle à GUITAR RIG, mais il
peut envoyer des signaux MIDI à d’autres applications.

(12) Le port USB permet de connecter l'appareil à votre ordinateur. Votre ordinateur doit gérer
la norme USB 2.0 pour fonctionner avec l'appareil. Le boîtier utilise également l'alimentation
du port USB pour fonctionner. Branchez directement le boîtier à un port USB 2.0 de votre or-
dinateur et évitez d’utiliser les hubs USB non alimentés. Nous vous recommandons de toujours
sécuriser votre câble USB en l'enroulant autour du crochet prévu à cet effet.

Le boîtier RIG KONTROL
Panneau arrière
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4 Installation sous Windows

 

Ce chapitre décrit l’installation du boîtier RIG KONTROL sous Windows 7, et plus particulière-
ment sur la configuration de l’interface audio. Pour activer le pédalier en tant que contrôleur
dans GUITAR RIG et utiliser ses capacités MIDI, veuillez consulter le chapitre ↑7, Utiliser le
RIG KONTROL comme contrôleur du présent manuel.

Pour des informations détaillées sur le logiciel GUITAR RIG, veuillez consulter le manuel Ap-
plication Reference. Vous le trouverez sur le disque d’installation ainsi que dans le menu Help
> Open Manual > Français de GUITAR RIG.

4.1 Installation du logiciel
 

Assurez-vous d'être connecté(e) à votre ordinateur avec les droits d'administration. Ne connec-
tez pas encore le RIG KONTROL.

1. Naviguez dans le contenu du DVD et localisez le fichier d’installation. Si vous utilisez une
version téléchargée de GUITAR RIG, il vous faut d’abord décompresser les fichiers d’in-
stallation.

Installation sous Windows
Installation du logiciel
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2. Double-cliquez sur le fichier d'installation ("Guitar Rig 5 [numéro de version] Setup
PC.exe") pour démarrer la procédure d'installation.

.
3. Suivez les instructions s'affichant à l'écran – elles vous guideront au cours de la procédu-

re d’installation du logiciel. Nous recommandons d'installer le logiciel dans les dossiers
d'installation par défaut.

4. Il vous sera demandé de spécifier le chemin d'accès au dossier des plug-ins VST sur votre
système. Si vous ne savez pas ce qu'est un plug-in VST, ou si vous comptez utiliser GUI-
TAR RIG uniquement en mode autonome (Standalone), utilisez le réglage proposé par dé-
faut. Si vous désirez utiliser GUITAR RIG en tant que plug-in dans un logiciel hôte, il

Installation sous Windows
Installation du logiciel
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vous faut spécifier ici le chemin d'accès au dossier des plug-ins VST de votre logiciel hô-
te.

.

Installation sous Windows
Installation du logiciel
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5. Il vous sera demandé si vous souhaitez installer les pilotes pour les interfaces audio GUI-
TAR RIG. Cochez la case située à côté de Install the Rig Kontrol 3 Driver, puis cliquez sur
Next.

.
6. Une fois l'installation achevée, il peut vous être demandé de redémarrer votre ordinateur.
Les applications suivantes ont été placées sur votre disque dur :

▪ L'application GUITAR RIG autonome et complète

▪ Les plug-ins GUITAR RIG : utilisez GUITAR RIG comme plug-in dans le séquenceur de
votre choix. Sur les ordinateurs Windows, GUITAR RIG peut fonctionner en plug-in aux
formats VST et RTAS.

▪ Le Service Center : cette application est le gestionnaire d'activation des produits et de mi-
se à jour. Veuillez consultez le Guide d’Installation pour plus de détails.

▪ Les pilotes du RIG KONTROL.

Si vous souhaitez installer uniquement les pilotes de l’interface, un fichier installeur distinct
est disponible sur le DVD d’installation. Vous pouvez également en télécharger la version la
plus récente depuis la section d’Assistance (Support) du site web de Native Instruments.

Installation sous Windows
Installation du logiciel
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4.2 Installation du matériel
 

Utilisez le câble USB fourni pour brancher le RIG KONTROL à un port USB 2.0 de votre ordi-
nateur.

Connection du contrôleur à votre ordinateur.

Le RIG KONTROL est alimenté via USB. Le fonctionnement n’est garanti qu’en périphérique
unique, sur un contrôleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté.

► Une fois le pilote correctement installé, le RIG KONTROL est reconnu automatiquement. Si
ce n’est pas le cas, relancez l’installation du logiciel comme expliqué ci-dessus.

Plusieurs modules du pilote sont alors assignés au RIG KONTROL ; chacun entraîne l'appari-
tion d'une fenêtre spécifiant l'installation du pilote concerné.

Sur un ordinateur Windows, le pilote est associé à un port USB particulier. Si vous branchez
le câble USB sur un autre port que celui sur lequel le pilote a été installé, le processus d’as-
signation du pilote est relancé.

Si à un moment ou à un autre, l’ordinateur semble ne pas reconnaître le RIG KONTROL, dé-
connectez le câble USB, attendez quelques secondes, puis reconnectez-le. Si le problème
persiste, redémarrez votre ordinateur avec l’interface connectée.

Installation sous Windows
Installation du matériel

 

RIG KONTROL 3 - Manuel d’utilisation - 18



4.3 Configuration
 

Ce chapitre décrit comment utiliser l’interface audio RIG KONTROL sous Windows, en particu-
lier avec le logiciel GUITAR RIG. Nous supposons ici que vous avez déjà activé GUITAR RIG
via le Service Center. Si ce n'est pas le cas, veuillez consulter le Guide d’Installation pour plus
de détails concernant l'enregistrement de votre logiciel.

4.3.1 Configuration de GUITAR RIG
 

Nous allons maintenant configurer GUITAR RIG pour utiliser l’interface audio RIG KONTROL.

► Veuillez tout d’abord lancer le logiciel.

Lorsque le logiciel est lancé pour la première fois, la fenêtre Audio and MIDI Settings s’ouvre
automatiquement ; c’est là que vous devez effectuer les réglages suivants (pour accéder à ces
réglages ultérieurement, sélectionnez File > Audio and MIDI Settings dans le menu du logi-
ciel).

Installation sous Windows
Configuration
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La fenêtre de dialogue Audio and MIDI Settings.

1. Sous l'onglet Audio, choisissez ASIO dans le menu déroulant Driver.
2. Dans le menu déroulant Device, sélectionnez RIG KONTROL 3.
3. Choisissez un taux d’échantillonnage (Sample Rate) compatible avec votre application

musicale et adapté à la puissance de votre ordinateur. Par défaut, le taux d’échantillonna-
ge est de 44100 Hz (qualité CD). Les taux d’échantillonnage plus élevés peuvent amélio-
rer la qualité audio, mais ils entraînent également une charge de calcul plus élevée pour
le processeur ; 44100 Hz est un réglage tout à fait standard.

Si le RIG KONTROL 3 n’apparaît pas dans la liste, quelque chose ne va pas. Relancez l’in-
stallation de la manière décrite à la section ↑4.1, Installation du logiciel.

Configuration avancée

Pour les réglages de configuration avancés utilisant la fenêtre de contrôle du pilote, veuillez
vous référer à la section ↑5.4, Connexions audio et niveaux.

Installation sous Windows
Configuration
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4.3.2 Utiliser le RIG KONTROL comme interface audio par défaut
 

Si vous souhaitez utiliser le RIG KONTROL pour la lecture dans toutes vos applications audio
sur votre ordinateur (et non uniquement pour vos logiciels de musique), vous devez le définir
comme interface audio par défaut. Sous Windows 7, faites comme suit :

1. Ouvrez Démarrer > Panneau de configuration > Matériel et Audio > Son.
2. Sélectionnez l’onglet Lecture.
3. Dans la liste des périphériques, sélectionnez Rig Kontrol 3 Output puis cliquez sur Définir

Par Défaut.
4. Sélectionnez l’onglet Enregistrement.
5. Dans la liste des périphériques, sélectionnez Rig Kontrol 3 Input puis cliquez sur Définir

Par Défaut.

Installation sous Windows
Configuration
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6. Cliquez sur OK pour fermer la boîte de dialogue.

4.4 Connexions audio et niveaux
 

Dans les sections qui suivent, vous apprendrez à connecter votre guitare et votre système d'am-
plification au RIG KONTROL ainsi qu'à régler correctement les niveaux d'amplification, du cô-
té matériel comme du côté logiciel. Veuillez commencer par lancer le logiciel GUITAR RIG.

4.4.1 Connecter votre instrument et ajuster le niveau d’entrée
 

1. Diminuez le volume sur votre système d’amplification afin d’éviter toute lésion auditive.

Installation sous Windows
Connexions audio et niveaux
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2. Vérifiez que le sélecteur d'entrée est réglé sur « amplification d'entrée instrument » (bou-
ton LINE/INST à l'arrière du RIG KONTROL relâché), sauf si vous utilisez un préampli
pour amener votre signal au niveau ligne.

3. Branchez le câble connecté à votre guitare ou basse dans l'une des entrées du RIG KON-
TROL.

4. Baissez complètement le volume du canal d’entrée que vous n’utilisez pas.
Gardez à l’esprit qu'un instrument générant un signal stéréo (par exemple un synthétiseur) né-
cessite d'être connecté aux deux canaux d’entrée afin d'obtenir un son stéréo.

Connecter une guitare ou une guitare basse au contrôleur.

Afin d'obtenir la meilleure qualité sonore, il convient d'avoir un signal suffisamment puissant ;
pour cela, il vous faut ajuster précautionneusement le niveau d'entrée du RIG KONTROL. L’In-
dicateur de Niveau d'Entrée (Input Level) vous aidera à visualiser le niveau du signal entrant :

État de l’indicateur Signification

Toutes les diodes sont
éteintes

Aucun signal en entrée

Diodes vertes allumées Signal entrant

Diodes vertes et rouges al-
lumées

Le signal entrant est trop
fort

Installation sous Windows
Connexions audio et niveaux
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Avant d’ajuster le gain d’entrée, montez le volume sur votre guitare. Grattez quelques cordes
avec le volume que vous comptez utiliser lors de l’enregistrement, et regardez l’Indicateur In-
put Level :

1. Montez le niveau d’entrée situé près de la prise jack utilisée jusqu’à ce que l’indicateur
commence tout juste à passer dans le rouge lorsque vous jouez.

2. Maintenant, tournez très légèrement le curseur de gain en arrière, jusqu’à ce que l’indica-
teur revienne dans la zone verte, même quand vous jouez vraiment fort sur votre instru-
ment.

La sensibilité d'entrée est maintenant réglée à son niveau optimal, permettant ainsi au RIG
KONTROL de fournir la plus grande dynamique d'amplitude sans toutefois saturer.

4.4.2 Connecter un deuxième instrument
 

Vous pouvez connecter des instruments différents aux canaux d’entrée tant qu’ils fournissent
tous les deux un signal au même niveau (ligne ou instrument). Branchez tout simplement le
câble du deuxième instrument dans la prise de l’autre entrée et ajustez son niveau d'entrée
comme indiqué dans la section précédente.

Si un seul canal est utilisé, réglez le Gain de l’autre canal sur zéro.

Pour les instruments générant un signal stéréo, le second canal doit être connecté pour obtenir
un son stéréo.

4.4.3 Le niveau d’entrée de GUITAR RIG
 

Nous supposons ici que votre guitare est connectée au RIG KONTROL et que son niveau d’en-
trée est correctement réglé (cf. section ↑4.4.1, Connecter votre instrument et ajuster le niveau
d’entrée). Vous devez maintenant vous assurer que le signal d'entrée est traité à un niveau cor-
rect par le logiciel.

Jetez un œil à l'en-tête de la fenêtre de GUITAR RIG : il contient le module d'entrée avec le
sélecteur de canal (L/R), une porte de bruit (noise gate) basique, le module de sortie avec un
limiteur et des informations sur la consommation de ressources processeur.

L'en-tête du logiciel GUITAR RIG.
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Notez que l’Indicateur de niveau d'entrée (Input) affiche une certaine amplitude lorsque vous
jouez. Il dispose également d’un réglage de volume intégré qui permet de contrôler le niveau
d’entrée. Ajustez-le de manière à obtenir le niveau le plus élevé possible sans que votre signal
ne sature. Il faut que l'Indicateur de niveau d'entrée s’approche du rouge sans toutefois l’at-
teindre.

Si une seule guitare est connectée, GUITAR RIG reçoit un signal mono. Vous pouvez configurer
le composant Input afin qu'il route le signal de votre guitare vers les deux canaux. Par défaut,
GUITAR RIG est réglé pour traiter les deux canaux d'entrée (L et R sont activés) ; en toute logi-
que, l'un des deux canaux d'entrée reste muet. Pour modifier ceci, cliquez sur le bouton appro-
prié (L ou R) à gauche de l'Indicateur de niveau d'entrée, afin qu'un seul canal d'entrée soit
actif. Ceci effectuera le routage du signal mono sur les deux canaux.

4.4.4 Connecter la sortie
 

Le RIG KONTROL possède deux sorties mono (L/R) pour connecter votre système d’écoute,
qu’il s’agisse d’une console de mixage, d’une paire d'enceintes actives ou de votre chaîne hifi
stéréo. Ayez en tête que les deux sorties doivent être connectées pour avoir un son stéréo. Une
sortie stéréo séparée (TRS) vous permet de connecter votre casque.

Connecter des enceintes et un casque au contrôleur.

Installation sous Windows
Connexions audio et niveaux

 

RIG KONTROL 3 - Manuel d’utilisation - 25



1. Connectez les câbles de sortie aux entrées de votre amplificateur avec le volume de celui-
ci réglé au minimum.

2. Si vous utilisez un casque, connectez-le à la sortie casque et placez-le sur votre tête avec
le volume casque réglé au minimum.

3. Rendez-vous dans le Preset Browser et sélectionnez un preset quelconque en cliquant
dessus.

4. Commencez à jouer et augmentez avec précaution le volume de votre amplificateur ou ce-
lui de la sortie casque du RIG KONTROL jusqu’au niveau souhaité.

Tout est prêt, vous pouvez envoyer la sauce !
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5 Installation sous Mac OS X

 

Ce chapitre décrit l’installation de base du boîtier RIG KONTROL sous Mac OS X, et plus parti-
culièrement sur la configuration de l’interface audio. Pour activer le pédalier en tant que con-
trôleur dans GUITAR RIG et utiliser ses capacités MIDI, veuillez consulter le chapitre ↑7, Utili-
ser le RIG KONTROL comme contrôleur du présent manuel.

Pour des informations détaillées sur le logiciel GUITAR RIG, veuillez consulter le manuel Ap-
plication Reference. Vous le trouverez sur le disque d’installation ainsi que dans le menu Help
> Open Manual > Français de GUITAR RIG.

5.1 Installation du logiciel
 

Assurez-vous d'être connecté(e) à votre ordinateur avec les droits d'administration. Ne connec-
tez pas encore le RIG KONTROL.

1. Naviguez dans le contenu du DVD, et localisez le fichier d'installation de GUITAR RIG. Si
vous utilisez une version téléchargée de GUITAR RIG, il vous faut d’abord décompresser
le fichier d’installation.

2. Double-cliquez sur le fichier de l’installeur pour démarrer la procédure d’installation.
3. Suivez les instructions s’affichant à l’écran – elles vous guideront au cours de la procédu-

re d’installation du logiciel.
4. Il vous sera demandé si vous souhaitez installer les pilotes pour les interfaces audio de

GUITAR RIG. Sélectionnez le pilote RIG KONTROL 3 (il peut être pré-sélectionné), et cli-
quez sur Continue.

5. Une fois l’installation achevée, redémarrez votre ordinateur.
Les applications suivantes sont placées sur votre disque dur :

▪ L'application GUITAR RIG autonome et complète

▪ Les plug-ins GUITAR RIG : utilisez GUITAR RIG comme plug-in dans le séquenceur de
votre choix.

▪ Le Service Center : cette application est le gestionnaire d'activation des produits et de mi-
se à jour. Veuillez consultez le Guide d’Installation pour plus de détails.
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▪ Les pilotes du RIG KONTROL.

Si vous n’avez encore jamais possédé de produit NATIVE INSTRUMENTS, il vous faudra
vous enregistrer en suivant les instructions à l’écran. Vous trouverez plus d’informations con-
cernant la création d’un Compte Utilisateur NI et l’activation de GUITAR RIG dans le Guide
d’Installation et le Manuel du Service Center, situés dans le dossier d’installation du Service
Center.

Si vous souhaitez installer uniquement les pilotes de l’interface, un fichier installeur distinct
est disponible sur le DVD d’installation. Vous pouvez également en télécharger la version la
plus récente depuis la section d’Assistance (Support) du site web de Native Instruments.

5.2 Installation du matériel
 

Utilisez le câble USB fourni pour brancher le RIG KONTROL à un port USB 2.0 de votre ordi-
nateur.

Connection du contrôleur à votre ordinateur.

Le RIG KONTROL est alimenté via USB. Le fonctionnement n’est garanti qu’en périphérique
unique, sur un contrôleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté.

► Une fois le pilote correctement installé, le RIG KONTROL est reconnu automatiquement. Si
ce n’est pas le cas, relancez l’installation du logiciel comme expliqué ci-dessus.
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Plusieurs modules du pilote sont alors assignés au RIG KONTROL ; chacun entraîne l'appari-
tion d'une fenêtre spécifiant l'installation du pilote concerné.

Si à un moment ou à un autre, l’ordinateur ne semble pas reconnaître le RIG KONTROL, dé-
connectez le câble USB, attendez quelques secondes, puis reconnectez-le. Si le problème
persiste, redémarrez votre ordinateur avec l’interface connectée.

5.3 Configuration
 

Ce chapitre décrit comment utiliser l’interface audio RIG KONTROL sous Mac OS X, en parti-
culier avec le logiciel GUITAR RIG. Nous supposons ici que vous avez déjà activé GUITAR RIG
via le Service Center. Si ce n'est pas le cas, veuillez consulter le Guide d’Installation pour plus
de détails concernant l'enregistrement de votre logiciel.

5.3.1 Configuration de GUITAR RIG
 

Nous allons maintenant configurer GUITAR RIG pour utiliser l’interface audio RIG KONTROL.
Veuillez tout d'abord lancer le logiciel.
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1. Lorsque le logiciel est lancé pour la première fois, la fenêtre Audio and MIDI Settings
s’ouvre automatiquement ; c’est là que vous devez effectuer les réglages suivants. Si vous
voulez accéder à ces réglages plus tard, sélectionnez Guitar Rig > Preferences dans le
menu du programme.

.
2. Sous l'onglet Audio, choisissez CoreAudio comme dans le menu Driver.
3. Dans le menu déroulant Device, sélectionnez RigKontrol3.

Si le RIG KONTROL n’apparaît pas dans la liste alors qu’il est connecté, quelque chose ne
va pas. Relancez l’installation de la manière décrite à la section ↑5.1, Installation du logi-
ciel.

L’interface audio peut être configurée via les paramètres suivants :

▪ Sample Rate (taux d’échantillonnage) : choisissez un taux d’échantillonnage compatible
avec votre logiciel audio et adapté à la puissance de votre ordinateur. Par défaut, le taux
d’échantillonnage est de 44100 Hz (qualité CD). Les taux d’échantillonnage plus élevés
peuvent améliorer la qualité audio, mais ils entraînent également une charge de calcul
plus élevée pour le processeur.
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Le taux d’échantillonnage définit le nombre d’échantillons lus/enregistrés par seconde de
son. Un taux d’échantillonnage plus élevé offre une meilleure qualité audio ; toutefois,
44100 Hz (utilisé pour les CD audio) est un réglage standard, parfaitement suffisant dans la
plupart des situations. Si la destination finale de votre production est un CD, vous devriez
utiliser ce réglage ou l’un de ses multiples (88200 Hz). Pour info : les enregistreurs DAT et
les DVD (films) utilisent un taux d’échantillonnage de 48000 Hz. Les valeurs à partir de
96000 Hz sont typiques des enregistrements audio sur DVD, HD DVD et Blu-ray. Ayez tou-
jours en tête qu’un taux d’échantillonnage plus élevé appelle une consommation accrue de
ressources CPU.

▪ Latency : utilisez la tirette Latency pour régler la taille du tampon de l’interface audio,
mesurée en échantillons. Ceci a deux effets : plus le tampon audio est grand, plus la pro-
babilité de ruptures audio est faible. D’un autre côté, la taille du tampon affecte directe-
ment la latence globale (le délai) de votre système. Plus la latence est élevée, plus le
temps entre l’instant où vous jouez une note et celui où vous l’entendez est long.

Nous vous recommandons de commencer avec la taille de tampon proposée par défaut, puis
de continuer avec les autres étapes de la configuration. Une fois le tout achevé, chargez un
preset de base et revenez à la fenêtre Audio and MIDI Settings pour trouver le meilleur réglage
de latence pour votre système. Ceci s'effectue en diminuant progressivement la taille du tam-
pon : glissez la tirette de latence vers la gauche tout en jouant quelque chose. Lorsque vous
commencez à entendre des craquements ou des ruptures de son, glissez lentement la tirette
vers la droite jusqu'à ce que ces artefacts aient entièrement disparu.

5.3.2 Utiliser le RIG KONTROL comme interface audio par défaut
 

Si vous souhaitez utiliser le RIG KONTROL pour la lecture dans toutes vos applications audio
sur votre ordinateur (et non uniquement pour vos logiciels de musique), vous devez le définir
comme interface audio par défaut. Sous Mac OS X, faites comme suit :

1. Dans le Menu Pomme, choisissez Préférences Système.
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2. Dans le Panneau qui s’ouvre alors, cliquez sur Son.

.
3. Sur l’onglet Effets Sonores, sélectionnez RigKontrol3 dans le menu Émettre Alertes et Ef-

fets Sonores via.
4. Cliquez sur l’onglet Sortie et sélectionnez RigKontrol3 dans la liste Choisissez un appareil

pour la sortie son.
5. Cliquez sur l’onglet Entrée et sélectionnez RigKontrol3 dans la liste Choisissez un appa-

reil pour l'entrée son.
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5.4 Connexions audio et niveaux
 

Dans les sections qui suivent, vous apprendrez à connecter votre guitare et votre système d'am-
plification au RIG KONTROL ainsi qu'à régler correctement les niveaux d'amplification, du cô-
té matériel comme du côté logiciel. Veuillez commencer par lancer le logiciel GUITAR RIG.

5.4.1 Connecter votre instrument et ajuster le niveau d’entrée
 

1. Diminuez le volume sur votre système d’amplification afin d’éviter tout dommage auditif.
2. Vérifiez que le sélecteur d'entrée est réglé sur « amplification d'entrée instrument » (bou-

ton LINE/INST à l'arrière du RIG KONTROL relâché), sauf si vous utilisez un préampli
pour amener votre signal au niveau ligne.

3. Branchez le câble connecté à votre guitare ou basse dans l'une des entrées du RIG KON-
TROL.

4. Diminuez complètement le volume du canal d’entrée que vous n’utilisez pas.
Gardez à l’esprit qu'un instrument générant un signal stéréo (par exemple un synthétiseur) né-
cessite d'être connecté aux deux canaux d’entrée afin d'obtenir un son stéréo.

Connecter une guitare ou une guitare basse au contrôleur.
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Afin d'obtenir la meilleure qualité sonore, il convient d'avoir un signal suffisamment puissant ;
pour cela, il vous faut ajuster précautionneusement le niveau d'entrée du RIG KONTROL. L’In-
dicateur de Niveau d'Entrée (Input Level) vous aidera à visualiser le niveau du signal entrant :

État de l’indicateur Signification

Toutes les diodes sont
éteintes

Aucun signal en entrée

Diodes vertes allumées Signal entrant

Diodes vertes et rouges al-
lumées

Le signal entrant est trop
fort

Avant d’ajuster le gain d’entrée, montez le volume sur votre guitare. Grattez quelques cordes
avec le volume que vous comptez utiliser lors de l’enregistrement, et regardez l’Indicateur In-
put Level :

1. Montez le niveau d’entrée situé près de la prise jack utilisée jusqu’à ce que l’indicateur
commence tout juste à passer dans le rouge lorsque vous jouez.

2. Maintenant, tournez très légèrement le curseur de gain en arrière, jusqu’à ce que l’indica-
teur revienne dans la zone verte, même quand vous jouez vraiment fort sur votre instru-
ment.

La sensibilité d'entrée est maintenant réglée à son niveau optimal, permettant ainsi au RIG
KONTROL de fournir la plus grande dynamique d'amplitude sans toutefois saturer.

5.4.2 Connecter un second instrument
 

Vous pouvez connecter des instruments différents aux canaux d’entrée tant qu’ils fournissent
tous les deux un signal au même niveau (ligne ou instrument). Branchez simplement le câble
du second instrument dans la prise de l’autre entrée et ajustez son niveau d'entrée comme in-
diqué dans la section précédente.

Si un seul canal est utilisé, réglez le Gain de l’autre canal sur zéro.

Pour les instruments générant un signal stéréo, le second canal doit être connecté pour avoir
un son stéréo.
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5.4.3 Le niveau d’entrée de GUITAR RIG
 

Nous supposons ici que votre guitare est connectée au RIG KONTROL et que son niveau d’en-
trée est correctement réglé (cf. section ↑5.4.1, Connecter votre instrument et ajuster le niveau
d’entrée). Vous devez maintenant vous assurer que le signal d'entrée est traité à un niveau cor-
rect par le logiciel.

Jetez un œil à l'en-tête de la fenêtre de GUITAR RIG : il contient le module d'entrée avec le
sélecteur de canal (L/R), une porte de bruit (noise gate) basique, le module de sortie avec un
limiteur et des informations sur la consommation de ressources processeur.

L'en-tête du logiciel GUITAR RIG.

Notez que l’Indicateur de niveau d'entrée (Input) affiche une certaine amplitude lorsque vous
jouez. Il dispose également d’un réglage de volume intégré qui contrôle le niveau d’entrée du
logiciel. Ajustez-le de manière à obtenir le niveau le plus élevé possible sans que votre signal
ne sature. Il faut que l'Indicateur de niveau d'entrée s’approche du rouge sans toutefois l’at-
teindre.

Si une seule guitare est connectée, GUITAR RIG reçoit un signal mono. Vous pouvez configurer
le composant Input afin qu'il route le signal de votre guitare vers les deux canaux. Par défaut,
GUITAR RIG est réglé pour traiter les deux canaux d'entrée (L et R sont activés) ; en toute logi-
que, l'un des deux canaux d'entrée reste muet. Pour modifier ceci, cliquez sur le bouton appro-
prié (L ou R) à gauche de l'Indicateur de niveau d'entrée, afin qu'un seul canal d'entrée soit
actif. Ceci effectuera le routage du signal mono sur les deux canaux.

5.4.4 Connecter la sortie
 

Le RIG KONTROL possède deux sorties mono pour connecter votre système d’écoute, qu’il
s’agisse d’une console de mixage, d’une paire d'enceintes actives ou de votre chaîne hifi sté-
réo. Ayez en tête que les deux sorties doivent être connectées pour avoir un son stéréo. Une
sortie stéréo séparée (TRS) vous permet de connecter votre casque.
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Connecter des enceintes et un casque au contrôleur.

1. Connectez les câbles de sortie aux entrées de votre amplificateur avec le volume de celui-
ci réglé au minimum.

2. Si vous utilisez un casque, connectez-le à la sortie et placez-le sur votre tête avec le volu-
me casque au minimum.

3. Rendez-vous dans le Preset Browser et sélectionnez un preset quelconque en cliquant
dessus.

4. Commencez à jouer et augmentez avec précaution le volume de votre amplificateur ou ce-
lui de la sortie casque du RIG KONTROL jusqu’au niveau souhaité.

Tout est prêt, vous pouvez envoyer la sauce !
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6 Configuration avancée

 

6.1 Configuration avancée sous Windows
 

Vous pouvez accéder au panneau de contrôle (Control Panel) du pilote en cliquant sur ASIO
Config, dans la fenêtre Audio and MIDI Settings (accessible depuis le menu File > Audio and
MIDI Settings dans GUITAR RIG).

Le Control Panel avec la page Audio Settings ouverte.

6.1.1 La page Audio Settings
 

Sur la page Audio Settings, vous pouvez régler la latence audio et le taux d’échantillonnage et
contrôler l’état de l’interface. La page Audio Settings comprend deux sections : Audio Process-
ing et Device Monitor.
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Section Audio Processing

La section Audio Processing permet de régler les paramètres de la conversion analogique-nu-
mérique/numérique-analogique effectuée par votre interface audio. Elle dispose de deux me-
nus :

▪ Sample Rate : choisissez un taux d’échantillonnage compatible avec votre logiciel audio
et adapté à la puissance de votre ordinateur. Un taux d’échantillonnage plus élevé amélio-
re la qualité audio mais nécessite plus de puissance CPU. Par défaut, le taux d’échantil-
lonnage est de 44100 Hz (qualité CD).

Le taux d’échantillonnage définit le nombre d’échantillons lus/enregistrés par seconde de
son. Un taux d’échantillonnage plus élevé offre une meilleure qualité audio ; toutefois,
44100 Hz (utilisé pour les CD audio) est un réglage classique qui est parfaitement suffisant
dans la plupart des situations. Si la destination finale de votre production est un CD, vous
devriez utiliser ce réglage ou l’un de ses multiples (88200 Hz). Pour info : les enregistreurs
DAT et les DVD (films) utilisent un taux d’échantillonnage de 48000 Hz. Les valeurs à partir
de 96000 Hz sont typiques des enregistrements audio sur DVD, HD DVD et Blu-ray. Ayez
toujours en tête qu’un taux d’échantillonnage plus élevé appelle une consommation accrue
de ressources CPU.

Si vous comptez utiliser plusieurs logiciels simultanément avec l’interface, gardez en tête
qu’ils devront tous partager le même taux d’échantillonnage.

▪ Process Buffer : diminuez la taille du tampon pour obtenir une réponse plus rapide de vo-
tre ordinateur aux actions dans les logiciels audio et sur les contrôleurs MIDI.

Lorsque l’information audio est transcrite du format analogique au format numérique et vice
versa, le pilote audio doit enregistrer les données sous forme de paquets tampons (tampons
audio), qui sont ensuite envoyés et traités par le processeur. Plus la taille de tampon est éle-
vée, plus le temps écoulé avant que le signal n’atteigne la sortie sous forme audio est long.
Vous rencontrerez peut-être ce phénomène sous la forme d’un léger décalage entre le mo-
ment où vous appuyez sur une touche de votre ordinateur ou de votre contrôleur et celui où
vous entendez effectivement le son résultant. Ce délai est appelé latence. La règle d’or est :
une taille de tampon plus petite entraîne une latence plus faible. Cependant, d’autres fac-
teurs entrent également en jeu dans la latence (par exemple la vitesse du processeur et la
taille de la mémoire vive). Commencez votre réglage à partir d’une valeur de taille de tampon
plutôt élevée, puis baissez-la jusqu'à trouver l’équilibre parfait pour votre système entre
jouabilité et qualité audio. Si la sortie audio produit des craquements, il est probable que la
taille de tampon choisie soit trop petite pour votre processeur ; en effet, les tailles de tam-
pon plus petites exigent plus de puissance processeur.
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▪ USB Buffer : utilisez ce menu si vous ne parvenez pas à obtenir un réglage de latence
satisfaisant à l'aide du menu Process Buffer. Baissez la taille de tampon USB pour définir
des paquets USB plus petits, qui devraient contribuer à réduire la latence audible. Si
vous remarquez des interruptions dans l'audio, augmentez la taille de tampon jusqu'à ob-
tenir un son clair et sans pertes.

Section Device Monitor

La section Device Monitor affiche des informations sur l’état de l’interface audio et sur la la-
tence de sortie de votre système. Elle contient deux affichages :

▪ Processing State : l’affichage Processing State donne des informations sur l’état actuel de
l’appareil. Il y a trois messages d’état possibles :

◦ Idle : l’interface est connectée, mais aucune donnée audio n’est transmise.

◦ Streaming : le pilote fonctionne et il est en train de traiter des données audio.

◦ Panic : le pilote a cessé de transmettre les données. Trop d’erreurs d’entrée/sortie USB
sont survenues lors de la communication avec l’interface.

▪ Output Latency : affiche la latence de sortie en millisecondes.

6.1.2 Page Diagnostics
 

Les informations fournies sur la page Diagnostics seront peut-être plus pertinentes pour les
utilisateurs chevronnés ; en tout état de cause, en cas de problème, il est toujours utile de ve-
nir jeter un œil à cette page.

La page Diagnostics possède trois sections :

▪ Drop-Out Detection : affiche les erreurs d'entrée/sortie USB et de sous-alimentation du
tampon, lorsqu'elles sont détectées.

▪ Connection Monitor : affiche les erreurs de connexion client-pilote et de données USB,
lorsqu'elles sont détectées.

▪ System Performance Test : permet de lancer un test de performance, afin de mesurer les
valeurs de latence.

▪ Information : affiche des informations sur le driver et la version du firmware. Il y a aussi
ici un lien vers le Guide de Dépannage.
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Section Drop-Out Detection

La section Drop-Out Detection possède deux affichages et un bouton :

▪ USB I/O Errors : compte les erreurs d'entrée/sortie USB. Un nombre élevé d'Erreurs d'en-
trée/sortie USB indique a priori que votre système est en surcharge.

▪ Buffer Underruns : le sous-traitement du tampon arrive lorsque votre ordinateur n’est pas
capable de traiter le tampon audio assez rapidement. Le sous-traitement du tampon peut
être causé par trop de tâches tournant en arrière-plan, ou un trop fort usage de la ressour-
ce CPU par un logiciel audio utilisant l’interface audio.

▪ Reset : un clic sur ce bouton permet de réinitialiser les compteurs d’erreurs.

Section Connection Monitor

La section Connection Monitor possède deux affichages et un bouton :

▪ Number of Clients : affiche le nombre de clients connectés à l’interface. Les applications
ASIO multiples sont comptées séparément ; les WDM et WASAPI augmentent le compte
de 1, quel que soit le nombre d’applications WDM/WASAPI jouant de l’audio.

▪ USB Data Errors : compte le nombre d’erreurs de données USB. Les erreurs de données
sur bus USB peuvent être causées par des câbles trop longs, ou de mauvaise qualité, ou
encore par des rayonnements de sources extérieures.

▪ Reset : un clic sur ce bouton permet de réinitialiser les compteurs d’erreurs.

Section System Performance Test

▪ Current Latency : Cliquez sur le bouton Start situé en-dessous pour faire afficher la valeur
de latence actuelle.

▪ Maximum Latency : affiche la plus haute valeur de latence atteinte pendant le cycle de
mesures.

◦ Cliquer sur Reset a le même effet que cliquer sur Start pour la première fois. Cela réin-
itialise la procédure de test, et relance un nouveau test pour obtenir des valeurs de la-
tence actualisées.

◦ Cliquez sur Stop pour arrêter le test. La valeur de latence maximum Maximum Latency
restera affichée.

Configuration avancée
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Section Information

La section Information possède deux affichages et un bouton :

▪ Driver Version : indique le numéro de version du pilote actuellement installé.

▪ Firmware Version : indique le numéro de version du microprogramme (firmware) actuelle-
ment installé.

▪ Troubleshooting Guide : Cliquez sur Show pour ouvrir le Guide de Dépannage.

6.2 Configuration avancée sous Mac OS X
 

Sous Mac OS X, tous les réglages utiles sont regroupés dans la fenêtre Audio and MIDI Set-
tings. Pour plus d'informations, veuillez consulter le chapitre ↑5.3, Configuration.

Configuration avancée
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7 Utiliser le RIG KONTROL comme contrôleur

 

Le RIG KONTROL améliore votre expérience avec GUITAR RIG en y intégrant un contrôleur
matériel en parfaite adéquation avec le logiciel. En plus de ses fonctions de contrôle intégrées,
il propose des connexions MIDI et deux prises pour des pédales ou des interrupteurs au pied.
Les sections qui suivent expliquent comment configurer le contrôleur pour exploiter au mieux
ces fonctions. Pour apprendre à assigner les fonctions de GUITAR RIG au contrôleur matériel,
veuillez vous référer au Guide Getting Started ainsi qu’au Manuel Application Reference.

Pour utiliser le RIG KONTROL comme contrôleur MIDI standard, il vous faudra utiliser le logi-
ciel Controller Editor inclus. Veuillez vous référer au Manuel du Controller Editor pour plus de
détails.

7.1 Activer le RIG KONTROL dans GUITAR RIG
 

Le RIG KONTROL est automatiquement activé dans GUITAR RIG lorsque vous branchez le
contrôleur. La première fois qu'il est activé, une fenêtre s'ouvre et vous demande de calibrer la
pédale. Veuillez actionner la pédale sur sa course complète puis cliquez sur OK. Pour recali-
brer la pédale à tout moment, allez dans les Options et sélectionnez Preferences. Cliquez sur
le bouton Reset près du champ RIG KONTROL Pedal Calibration.

Le contrôleur RIG KONTROL a son équivalent graphique dans GUITAR RIG, que vous pouvez
afficher en cliquant sur le bouton afficher/masquer le Virtual Rig Kontrol (au dessus du rack).

Si vous faites fonctionner plusieurs instances de GUITAR RIG (par exemple dans un séquen-
ceur), il vous faut définir laquelle d’entre elles est pilotée par le pédalier. Par défaut, le RIG
KONTROL est activé pour la première instance de GUITAR RIG que vous lancez. En cliquant
sur le bouton-diode Connect du Virtual Kontrol d’une autre instance, celle-ci hérite du contrôle
par le RIG KONTROL – une seule instance pouvant être pilotée à la fois !

Certaines fonctions sont assignées par défaut aux interrupteurs 5-8, comme indiqué par les la-
bels sur le contrôleur. Vous pouvez immédiatement parcourir les presets actuellement visibles
dans le Browser via les boutons 5 (Preset Prev) et 6 (Preset Next). Les boutons 7 et 8 permet-
tent d'activer l'accordeur et de taper un tempo avec le pied. Ces boutons peuvent bien sûr être
ré-assignés à d'autres fonctions, suivant votre bon vouloir.

Utiliser le RIG KONTROL comme contrôleur
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La manière la plus simple d’assigner un bouton ou la pédale du RIG KONTROL à n’importe
quelle fonction dans le rack consiste à glissez le contrôle en question depuis le Virtual Kontrol
pour le déposer sur le paramètre que vous souhaitez contrôler. Pour une description détaillée
de la manière dont fonctionnent les assignations du contrôleur, veuillez vous référer au Guide
Getting Started et au Manuel Application Reference.

7.2 Utiliser des contrôleurs MIDI via l’interface MIDI du RIG KONTROL
 

Si le RIG KONTROL est capable d’envoyer des messages MIDI pour piloter d’autres applica-
tions, il communique avec GUITAR RIG directement via USB. Il possède néanmoins une inter-
face MIDI standard avec une entrée et une sortie.

Pour utiliser un contrôleur connecté à l’entrée MIDI, vérifiez que le canal MIDI du RIG KON-
TROL est activé dans GUITAR RIG :

1. Ouvrez la fenêtre Audio and MIDI Settings. Sous Windows, elle est accessible depuis le
menu File. Sous Mac OS, elle est disponible dans le menu GUITAR RIG.

2. Allez dans l’onglet MIDI.
3. Dans le tableau Inputs, localisez l’entrée Rig Kontrol et activez-la en cliquant dans la co-

lonne Status.
Le canal d’entrée MIDI est défini sur la page Options de GUITAR RIG : sous l’onglet Preferen-
ces, cliquez sur le menu déroulant MIDI Channel et sélectionnez le canal souhaité (de 1 à 16
ou Omni). Pour apprendre à assigner des fonctions aux contrôleurs MIDI externes, veuillez vous
référer au Guide Getting Started ainsi qu'au Manuel Application Reference.

7.3 Utiliser des pédales et interrupteurs au pied supplémentaires
 

Le RIG KONTROL est équipé de deux prises permettant de connecter des interrupteurs au pied
et des pédales via des câbles jack 6,35 mm. Une fois ceux-ci connectés et configurés, ils peu-
vent être assignés comme n'importe quel autre contrôleur MIDI dans GUITAR RIG. Veuillez
vous référer au Guide Getting Started ainsi qu'au Manuel Application Reference pour découvrir
comment faire.

Sous l’onglet Preferences de la page Options de GUITAR RIG, les réglages suivants sont dispo-
nibles :

Utiliser le RIG KONTROL comme contrôleur
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► Pour calibrer une pédale externe, cliquez sur le bouton Reset situé près de Rig Kontrol Ext
Pedals Calibration.

Les deux lignes Rig Kontrol Ext Pedal 1/2 Mode vous permettent de configurer chacune des
deux entrées afin de les faire correspondre à vos interrupteurs au pied et pédales externes.
Veuillez consulter les spécifications fournies par le fabricant du produit pour déterminer le
type de connectique de la pédale (pointe active ou anneau actif), ou bien s’il s’agit d’un in-
terrupteur ouvrant ou fermant. Si un problème survient, essayez les autres modes disponi-
bles.

Utiliser le RIG KONTROL comme contrôleur
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8 Dépannage

 

Si vous rencontrez un quelconque problème avec votre matériel, nous vous recommandons de
suivre ces quelques étapes pour trouver la solution avant de contacter l’équipe d’assistance
technique :

▪ Rendez-vous sur la Base de Connaissances (Knowledge Base) en ligne de NI. Le moyen le
plus simple de la trouver est de sélectionner Help > Visit the Knowledge Base... dans le
menu de GUITAR RIG.

▪ Visitez le Forum Utilisateurs NI sur notre site web :
http://www.native-instruments.com/forum/

Lorsque vous prenez contact avec l’équipe d’assistance technique, vérifiez que vous avez à
portée de main toutes les informations nécessaires concernant votre ordinateur. Pour les infor-
mations sur la version du pilote et la révision du microprogramme (firmware), veuillez regarder
dans le Control Panel du pilote.

▪ Sur les ordinateurs Windows, vous trouverez les informations sur les versions du pilote et
du firmware dans le Control Panel du RIG KONTROL. Ouvrez le fichier Rig Kontrol 3 situé
dans le fichier des logiciels Native Instruments, et double-cliquez sur l'exécutable Rig
Control 3 Control Panel. Cliquez sur Help > About Rig Kontrol 3 Control Panel pour faire
afficher les informations.

▪ Sous Mac OS X, vous pouvez accéder au Control Panel du pilote depuis les Préférences
Système. Les informations sont affichées dans la fenêtre principale.

Pour contacter l’équipe d’assistance, veuillez vous rendre à cette URL :

http://www.native-instruments.com/support/

Pendant leur phase de développement, tous les produits Native Instruments sont testés de ma-
nière extensive dans des situations réelles. Néanmoins, si votre produit doit être renvoyé,
l’équipe d’Assistance Technique vous fournira un numéro RA (Return Authorization, Autorisa-
tion de Retour) pour accélérer le processus de retour. Veuillez contacter notre équipe d’Assis-
tance Technique avant de renvoyer un quelconque produit. Les paquets renvoyés sans ce nu-
méro RA ne pourront être correctement identifiés, et risquent ainsi de ne pas être pris en char-
ge efficacement.

Dépannage
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8.1 Problèmes audio
 

Cette section vous propose de l’aide pour les problèmes audio les plus courants.

8.1.1 Pas de son ou volume faible
 

Si votre sortie audio est muette ou faible, différentes causes sont possibles :

▪ Câbles débranchés ou défectueux. Veuillez vérifier tous les branchements et tous les câ-
bles.

▪ Mauvaise carte son ou entrée audio sélectionnée. Veuillez sélectionner l’entrée Audio and
MIDI Settings dans le menu de GUITAR RIG, afin de vérifier si le pilote du RIG KONTROL
est bien sélectionné dans la fenêtre qui s’ouvre alors.

▪ Mauvais canal choisi dans le module Input de GUITAR RIG. Connectez votre instrument à
l’autre entrée, ou bien passez à l’autre canal en le choisissant dans l'en-tête du logiciel.

▪ Le gain d’entrée du RIG KONTROL est trop faible. Augmentez le niveau d’entrée.

▪ Le potentiomètre de volume de votre instrument est réglé à un niveau trop faible. Tour-
nez-le pour augmenter le volume.

8.1.2 Signal distordu
 

Si le signal audio semble être distordu alors qu’aucune distorsion n’est ajoutée par le logiciel
GUITAR RIG, il est probable que le gain d’entrée du RIG KONTROL soit trop élevé. Réduisez
le niveau d'entrée (Input) sur l’interface pour empêcher la saturation du préamplificateur. Si
votre instrument produit un signal de niveau si fort que le préampli sature toujours, réduisez le
volume directement sur l'instrument. Généralement, ceci ne se produit que si l’instrument est
équipé d’une électronique active et de micros spéciaux à sortie haute puissance.

8.1.3 Bruit
 

Un bourdonnement audible peut avoir plusieurs origines, dont certaines sont détaillées ci-des-
sous :
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▪ Les micros à simple bobinage sont sensibles aux interférences électriques. Les micros à
double bobinage (humbuckers) produisent beaucoup moins de bruit, d’où leur nom (de
« hum » = « bourdonnement » et « to buck » = « réduire »...).

▪ Votre guitare est placée trop près d’un équipement électrique. Pour réduire ce type de
bourdonnement, éloignez la guitare de l’équipement électrique en question.

▪ Le potentiomètre de volume de la guitare est à un niveau trop faible. Tournez-le pour aug-
menter le volume. Si votre guitare possède plusieurs boutons de volume, assurez-vous de
les avoir tous vérifiés.

▪ Vous utilisez un câble pour guitare défectueux ou non blindé. Il est aussi possible que le
blindage de votre guitare elle-même soit inadéquat. Commencez par essayer de remplacer
votre câble de guitare par un modèle blindé. Si cela n’arrange rien, il vous faudra peut-
être faire réviser l’électronique et le blindage des cavités de votre guitare par un spécialis-
te.

Si vous entendez des sifflements, le niveau à l’entrée du préamplificateur du RIG KONTROL
est peut-être trop faible. Montez le volume de votre instrument ou augmentez le niveau d'en-
trée sur le RIG KONTROL. Pour plus d'informations concernant le réglage du niveau d'entrée,
veuillez vous reporter à la section 4.4 (Windows) ou à la section 5.4 (Mac OS X) de ce manuel.

8.1.4 Boucles de masse
 

Les boucles de masse (généralement perçues comme un bourdonnement ou un grésillement)
constituent un problème classique lorsque de multiples appareils électriques sont connectés
au même circuit d’alimentation électrique. Les étapes suivantes devraient vous aider à élimi-
ner une boucle de masse :

► Débranchez tous les appareils que vous n’utilisez pas actuellement, notamment les périphé-
riques externes de votre ordinateur (disques durs externes, graveurs de CD/DVD, etc.).

► Branchez un boîtier de direct (DI Box) derrière les sorties du RIG KONTROL. La plupart de
ces boîtiers disposent d’un interrupteur « ground lift » qui permet de briser la boucle de masse
et d’éliminer le bruit.

Dépannage
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8.2 Problèmes liés au matériel
 

Vérifiez régulièrement sur le site web de Native Instruments et via le Service Center de NI la
présence éventuelle de mises à jour pour le pilote du RIG KONTROL, ainsi que d'autres infor-
mations utiles.

8.2.1 Problèmes avec le pilote
 

Assurez-vous que le RIG KONTROL est connecté à l’ordinateur et ouvrez le Control Panel du
pilote. Lisez l’introduction du présent chapitre pour savoir comment trouver le Control Panel
du pilote.

Si vous ne réussissez pas à trouver le Control Panel, il est probable que le pilote ne soit pas du
tout installé. Dans ce cas, veuillez réinstaller le pilote comme décrit plus haut.

Si tous les menus déroulants du Control Panel sont grisés, le RIG KONTROL n’est pas reconnu
par le pilote. Il doit y avoir quelque chose d’anormal dans la connexion USB ; lisez les sections
suivantes pour plus de détails.

8.2.2 Problèmes avec l’USB
 

Le RIG KONTROL est une interface USB 2.0, et ne fonctionnera pas sur un port USB 1.0/1.1.
Connectez-le toujours directement à un port USB 2.0 de votre ordinateur. Le port doit satisfai-
re aux spécifications minimales USB 2.0, notamment à celles relatives à l'alimentation dispo-
nible (500 mA). Sur certains ordinateurs, les ports USB 2.0 ne satisfont pas aux spécifications
officielles de la norme USB 2.0. Si vous êtes dans ce cas, vous verrez peut-être apparaître un
message vous indiquant que l’alimentation est insuffisante pour faire fonctionner votre appa-
reil. Le RIG KONTROL peut alors produire des craquements, voire même ne pas fonctionner du
tout.

▪ Si votre ordinateur ne peut pas fournir la puissance électrique nécessaire via USB, es-
sayez de brancher le RIG KONTROL sur un hub USB 2.0 avec une alimentation externe.
Évitez de connecter d’autres appareils au hub, car tout périphérique alimenté par le hub
diminuerait la puissance électrique disponible.
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▪ En cas d’échec, il est toujours utile de vérifier si le RIG KONTROL fonctionne lorsque
vous déconnectez tous les appareils USB de votre ordinateur, à l’exception de votre cla-
vier et de votre souris.

▪ Si vous rencontrez des problèmes de ruptures dans l’audio ou d’autres problèmes en rela-
tion avec la connexion USB, branchez le RIG KONTROL sur un autre port USB 2.0.

▪ Un mauvais câble USB peut être responsable de ruptures dans l’audio et/ou d’autres pro-
blèmes de connexion. Essayez avec un autre câble possédant le symbole officiel USB ;
parfois, l’utilisation d’un câble plus court peut aussi résoudre le problème.

▪ Si votre RIG KONTROL plante ou fonctionne mal sur une machine Windows, la première
chose à faire est de désactiver la gestion de l’alimentation des contrôleurs USB, activée
par défaut. Ouvrez le Gestionnaire de Périphériques (Panneau de Configuration > Système
> Matériel), et effectuez un clic droit sur un hub USB afin d’en ouvrir les propriétés. Sur
l’onglet « Gestion de l’alimentation », décochez toutes les cases. Répétez l'opération pour
tous les hubs, et redémarrez.

8.2.3 Utiliser le RIG KONTROL avec un ordinateur portable
 

Veuillez vérifier que votre ordinateur est capable de gérer le traitement audio en temps réel
sans rupture. Il existe quelques logiciels gratuits permettant d’analyser votre système, par
exemple :

www.thesycon.de/deu/latency_check.shtml

Lancez ce logiciel avec le RIG KONTROL déconnecté. Dans le cas où votre ordinateur n’est pas
capable de gérer correctement un traitement audio en temps réel, l’outil affiche des barres de
latence rouges et reporte cette information dans la partie basse de la fenêtre.

De manière générale, il n’est pas recommandé d’utiliser un ordinateur portable avec une carte
graphique à mémoire partagée. Votre projet audio a besoin de toute la mémoire et de toute la
puissance de calcul disponibles !

Voici quelques conseils permettant d’optimiser les performances audio de votre ordinateur por-
table :

► Il est recommandé de ne pas faire fonctionner votre ordinateur portable sur sa batterie, car
il est probable que la gestion de l’alimentation diminue automatiquement la fréquence d’horlo-
ge du processeur afin d'économiser de la batterie.
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► Déconnectez tous les périphériques inutilisés (imprimante, scanner...). Ceci augmentera la
puissance de calcul disponible pour votre logiciel audio.

► Les ordinateurs portables sont souvent équipés de périphériques internes qui perturbent le
traitement audio, comme par exemple une carte réseau ou une carte réseau sans-fil. Il vous
faudra peut-être désactiver ces périphériques lorsque vous travaillerez avec le RIG KONTROL.

Dépannage
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9 Spécifications Techniques

 

Ce chapitre contient toutes les spécifications techniques concernant l’interface matérielle RIG
KONTROL.

9.1 Connexions
 

▪ 2 entrées jack (In 1, In 2) pour fiches jack mono de 6,35 mm (1/4’’).

▪ 2 sorties jack (Out 1, Out 2) pour fiches jack 6,35 mm (1/4’’) mono (asymétriques) ou
TRS (symétriques).

▪ 1 sortie casque jack pour fiche jack stéréo 6,35 mm (1/4’’).

▪ 2 entrées jack pour contrôleurs externes (pédales/interrupteurs au pied).

▪ (Pedal 1, Pedal 2) pour fiches jack stéréo 6.3 mm (1/4’’).

▪ 2 connecteurs MIDI (In/Out) DIN circulaires 5-broches.

▪ 1 prise USB 2.0 de Type B.

9.2 Spécifications audio
 

Entrées audio (Analogique/Numéri-
que)

 

Canaux 2

Sample Rate (Fréquence d’Echantil-
lonnage)

44,1, 48, 88,2, 96, 192 kHz

Résolution numérique 16 ou 24 Bits

Convertisseur Cirrus Logic
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Entrées instrument  

Impédance d’entrée 1 MOhm

Niveau Full Scale (gain max) -11,5 dBu

Niveau d’entrée maximal +16 dBu

Rapport Signal sur Bruit (pondéré) > 100 dB

Taux de distorsion harmonique (THD
+ N)

00,009%

Réponse en fréquence +/- 0,5 dB, 20 Hz – 24 KHz

Plage de dynamique 105 dB (ADC)

 

Entrées ligne  

Impédance d’entrée 44 kOhms

Niveau Full Scale (gain max) -5,5 dBu

Niveau d’entrée maximal +16 dBu

Rapport Signal sur Bruit (pondéré) > 100 dB

Taux de distorsion harmonique (THD
+ N)

00,009%

Réponse en fréquence +/- 0,5 dB, 20 Hz – 36 KHz

Plage de dynamique 105 dB (ADC)

 

Sorties audio (Numérique/Analogi-
que)

 

Canaux 2

Sample Rate (Fréquence d’Echantil-
lonnage)

44,1, 48, 88,2, 96, 192 kHz

Résolution numérique 16 ou 24 Bits

Convertisseur Cirrus Logic
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Sorties ligne  

Impédance de sortie 100 Ohms

Niveau maximal de sortie +6,3 dBu

Rapport Signal sur Bruit (pondéré) > 100 dB

Taux de distorsion harmonique (THD
+ N)

00,010%

Réponse en fréquence +/-0,5 dB 22 Hz – 44 kHz

Interrupteur de niveau haut/bas Pleine échelle 5 Vpp / -14 dB

 

Sortie casque  

Impédance de charge 8-600 Ohms

Niveau maximal de sortie 1,61 V RMS @ 100 Ohms

Rapport Signal sur Bruit (pondéré) > 91 dB

Taux de Distortion Harmonique (THD
+N) (à 60 Ohms)

00,013%

Réponse en fréquence +/-0,5 dB 22 Hz – 44 kHz

9.3 Alimentation électrique
 

Via l'interface USB 2.0, 5 V – 500 mA. L’appareil n’a pas besoin d’alimentation électrique sé-
parée ni de batterie, l’alimentation est fournie par le port USB. Cependant, le fonctionnement
du RIG KONTROL n’est garanti qu’en périphérique unique, sur un contrôleur USB 2 ou sur un
hub USB 2 auto-alimenté.

9.4 Dimensions et poids
 

▪ Dimensions : 360 x 237 x 102 mm (14.1 x 9.3 x 4 pouces)

▪ Poids : 2.6 kg (5.7 livres)

Spécifications Techniques
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9.5 Données Environnementales
 

▪ Température de fonctionnement : entre 0 et 40°C (32°F et 104°F) (humidité inférieure à
85 %)

▪ Température de stockage : entre -20 et 50°C (-4°F et 122°F) (humidité inférieure à
85 %)

9.6 Configuration Requise
 

▪ Mac OS X 10.6 (mise à jour la plus récente), Intel Core Duo, 1 GB de RAM, USB 2.0.

▪ Windows 7 (Service Pack le plus récent, 32-bit ou 64-bit), Intel Core Duo ou AMD Athlon
64, 1 GB de RAM, USB 2.0.
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